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MANUFACTURER ADDRESS 

AnaPico AG 
Europa-Strasse 9 
8152 Glattbrugg 

Switzerland 
Tel.:+41 44 440 00 50 

Email: support@anapico.com 
Website: www.anapico.com 

 
 
 
 

WARRANTY 

All AnaPico instruments are warranted against defects in material and workmanship for a period of two years from the 
date of shipment. AnaPico will, at its option, repair or replace products that prove to be defective during the warranty 
period, provided they are returned to AnaPico and provided the preventative maintenance procedures are followed. 
Repairs necessitated by misuse of the product are not covered by this warranty. No other warranties are expressed or 
implied, including but not limited to implied warranties of merchantability and fitness for a particular purpose. AnaPico is 
not liable for consequential damages. The warranty on the internal rechargeable batteries (option B3) is one year from 
the date of shipment. Battery replacement is available through AnaPico and its distributors. 

IMPORTANT!  PLEASE READ CAREFULLY 

COPYRIGHT 

This manual is copyright by AnaPico AG and all rights are reserved. No portion of this document may be reproduced, 
copied, transmitted, transcribed, stored in a retrieval system, or translated in any form or by any means such as 
electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without written permission of AnaPico AG. 

 

tel:0041444400050
http://www.anapico.com/
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General Remarks 

The devices described in this manual are signal generators that produce electromagnetic microwave 
signals. The frequency and power range depends on the chosen device model and options. The 
devices can produce different types of modulations, such as AM, FM, PM Pulse or Chirp. 

They can be used in a variety of applications such as research and development or manufacturing 
and testing of electronic components.   

Options, such as a 1URM Case, an intern rechargeable battery, a GPIB interface or different types of 
power range extensions can be added.  

Device specific parameters are covered by the related datasheet that can be downloaded at 
https://www.anapico.com/downloads/catalog-and-data-sheets/ 

Validity of this Manual 

This manual is valid for the following devices and theirs extended versions: 

• APSINX010 

• APSINXXG 

• APULNXX 

• APLCXX(-X) 

• APSYN420, APSYN140(-X) 

• APUASYN20(-X) 

• APMSYN, APMQS 

• APMSXXG 

Available Casing 

The devices are available in the following cases. 

 

Compact Portable Case (CPC) 

     

Figure 1: APULN40 in a Compact Portable Case (with touch display) 

 



 

  Page 6 – Signal Source Models – v3.07         Apr. 2024                           AnaPico AG - www.anapico.com – sales@anapico.com 

 

 

 
1U Rackmount (1URM) 

 
Figure 2: APSIN26G in a 1URM Case 

1U HI Case (HI) 

 
Figure 3: APSMXXG-4 in a 1U HI case 

2U HI Case 

 

Figure 4: APVSGXX-4 in a 2U case 

Desktop Enclosure 

 
Figure 5: APLC in a desktop enclosure 
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Module 

 

Figure 6: APMSYN as a compact module 

 

Figure 7: APMQS20  
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Data Connections 

The devices may only be connected to a network or a computer by using a shielded LAN cable. 
Unless shorter lengths are prescribed, a maximum length of 3 m must not be exceeded for the LAN 
and the USB connection.  

Signal Connections 

In general, all connections between the signal generator and another device should be made as 
short as possible and must be well shielded. It is recommended to use a high-quality cable with low 
loss especially for frequencies above 20 GHz. 

Transportation 

The devices must only be transported with the packaging supplied by the manufacturer. The device 
can be lifted up or transported in any orientation.   
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Safety Information 

The following pieces of information are important to prevent personal injury, loss of life or damage 
to the equipment. Please read them carefully. If the device is used in a manner not specified by this 
manual, the protection provided by the device may be impaired. 

Signal Symbol 

In this manual, the following symbols are used to warn the reader about risks and dangers. 

 

DANGER denotes a hazard for personal health or life. 

 

WARNING denotes a risk or danger, that could damage the 
device. 

Labels on Products 

The following labels are on the products. Familiarize yourself with the meaning of each of the labels 
before using the product. 

 

 Direct Current (DC) 

 
Alternating Current (AC) 

 

Earth (Ground) 

 

EU label for separate collection of electrical and electronic waste. 

 

Caution, general danger zone. Attend the manual and/or a notice on the 
device. 

 

General Safety Considerations 

FCC notice 

This equipment has been tested and found to comply with the limits for a Class A device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance 
with the instruction manual, may cause harmful interference to radio communications. 

Operation of this equipment in a residential area may cause harmful interference in which case the 
user will be required to correct the interference at his or her expense.  
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The instrument meets the EMC directive and the Low Voltage Directive described in the CE 
declaration. Please contact Support@anapico.com for more information. 

 

 

If products or their components are mechanically and/or 
thermally processed in a manner that goes beyond their 
intended use, hazardous substances (heavy-metal dust such as 
nickel) may be released. For this reason, the product may only 
be disassembled or opened by specially trained personnel. 
Improper disassembly may be hazardous to your health. 
National waste disposal regulations must be observed. 

 

 

 

https://www.anapico.com/support/
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Technical Specifications 

Minimum Distances 

 

 

For an adequate cooling, the minimum distances between the 

device and another object, such as walls, rack cabinet walls or 

other equipment must be respected. 

 

The minimum distances are: 
 

 

Minimum 
distances 
for the CPC: 
A: 150 mm 

 

Minimum 
distances 
for the 
modules 
(APMSYN22 & 
APMSYN40): 
A: 0 mm 

B: 0 mm 

C: 50 mm 

D: 50 mm 
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Minimum 
distances 
for the 
APMQS20: 
A: 0 mm 

B: 0 mm 

C: 50 mm 

D: 0 mm 

 

Minimum 
distances 
for the 1URM: 
A: 1 mm 

B: 35 mm 

C: 50 mm 

D: 50 mm 
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Minimum 
distances 
for the 2HU: 
A: 0 mm 

B: 0 mm 

C: 150 mm 

D: 150 mm 
 
 

 

 

Energizing and de-Energizing 

To energize the device, apply the following voltage to the following connector. 

 

 

Position of the 
power 
connector on 
the left.  
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Position of the 
power 
connector on 
the left.  

 
The 1URM case has a fuse, accessible from the outside. To change the fuse, pull out the mains plug, 
push the fuse holder into the back panel and turn it around 45°, then take the holder out. Replace 
the old fuse with a new one. It is forbidden to repair defect fuses or to bridge them by any means. 

Use only a fuse with the following specifications. 

To De-energize the device, pull out the power cable. 

 
 

 

Use the supplied power adapter from AnaPico to supply the 
CPC. Apply only a voltage with the values specified in the 
datasheet.  

If the back side of the 1URM case is not accessible during operation, make sure the rack has a 
power switch.  

 

Proper operation conditions 

The devices are designed for use in dry and clean environments. The CPC can also be used in field as 
long as the operating conditions are met. Operation in an environment with high dust content, high 
humidity, danger of explosion or chemical vapors is prohibited.  
Operating temperature range, storage and transportation temperature range and operating and 
storage altitude are device specific. These parameters are available in the device’s datasheet. 
In case of condensation 2 hours are to be allowed for drying prior operation. Operation is only allowed 
from a 3-terminal mains connector with a safety ground connection and a mains plug used in your 
specific country. For sufficient ventilation, ensure open ventilation holes. 
 

 

Environmental Information 

1. Waste electrical and electronic equipment must not be disposed of with unsorted municipal 
waste, but must be collected separately. Contact the AnaPico customer service center for 
environmentally responsible disposal of the product. 

2. Specially marked equipment has a battery or accumulator that must not be disposed of with 
unsorted municipal waste, but must be collected separately. It may only be disposed of at a suitable 
collection point or via AnaPico service center.  
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Introduction 

This instruction manual is valid for AnaPico model series APSIN, APMS, APULN, APLC, APUASYN, 
APSYN, APMSYN, APMQS and APGEN. Chapter Getting Started gives guidance for a quick and easy 
setup of your new instrument. Chapter Remote Programming the Signal Generator describes the 
remote operation via AnaPico graphical user interface (GUI). Chapter Local Operation via Front 
Panel describes control via front panel and applies only to APSIN models. 

Included Material 

Your signal generator kit contains the following items: 

• Signal Generator 

• Universal power adaptor (AC 100 – 240V) with corresponding country specific plugs 

• Ethernet Cable 

• Manuals as PDF & software 



 

  Page 16 – Signal Source Models – v3.07         Apr. 2024                           AnaPico AG - www.anapico.com – sales@anapico.com 

 

 

 

Getting Started 

System Requirements 

The AnaPico graphical user interface requires at least the minimum system requirements to run one 
of the supported operating systems.  

Operating system  Windows™ 2000 SP4, XP SP2, Vista, 7, 8, 10, 11 

Remote connection 10/100/1000M Ethernet or USB 2.0 Port 

Initial Inspection 

Inspect the shipping container for damage. If container is damaged, retain it until contents of the 
shipment have been verified against the packing list and instruments have been inspected for 
mechanical and electrical operation. 

Unpacking the Instrument 

Remove the instrument materials from the shipping containers. Save the containers for future use. 

For a list of material included in the standard package, please refer to chapter Included Material. 

Starting the Instrument 

This section describes installation instructions and verification tests. 

Applying Power 

Place the instrument on the intended workbench and connect the appropriate DC power supply to 
the receptacle on the rear of the unit. Make sure you use the included DC power supply.  

 

Using other supplies may lead to malfunction and damage of 
the Instrument. 

 
Press the line on/off switch on the rear panel. If available, the front panel display will illuminate. The 
instrument will initialize and momentarily display the model number, firmware revision and product 
serial number. The display will then switch to the factory default display setting, showing preset 
frequency (100 MHz) and power, phase lock status (of internal reference) and instrument 
connectivity status (Ethernet IP or USB identifier).  

Note, the instrument booting process may take up to 60 seconds (depending on configuration) to 
complete. 

Connecting to LAN 

Connect the instrument to your local area network (LAN) using the Ethernet cable. By default, the 
instrument is configured to accept its dynamic IP number from the DHCP server of your network. If it 
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is configured properly, your network router will assign a dynamic IP number to the instrument which 
will be automatically displayed on the screen. Your instrument is now ready to receive remote 
commands. 

Direct connectivity to host via Ethernet cable (no router) 

You can connect to the instrument to your computer with the Ethernet cable without using a local 
area network with DHCP server.  To work properly, the network controller (NIC) of your computer 
must be set to an IP address following the ZEROCONF standard, beginning with 169.254.xxx.xxx 
(excluding 169.254.1.0 and 169.254.254.255) and network mask 255.255.0.0 to match the 
ZEROCONF IP that the signal generator will assign itself after DHCP timeout. Any fixed address in the 
abovementioned range is admissible as well. The generators ZEROCONF address cannot be 
predicted as it is assigned dynamically, however the ZEROCONF address assignment process ensures 
it will not conflict with any other address used in the network. 

Connection from a NIC that is configured to use DHCP is also possible. After a pre-set timeout, the 
NIC will assume that no DHCP is available and self-assign a fallback IP that will fall into the range 
169.254.xxx.xxx. 

Alternatively, you may assign the instrument a fixed IP. Please refer to a later section of this manual 
to learn how to do this. 

Connecting through USB 

Connect the (powered on) instrument to the computer using a quality USB type-A to type-B cable. If 
properly connected, the computer host should automatically recognize your instrument as a 
USBTMC device. 

Note if you want to work with the AnaPico GUI, it must be installed with USB support selected. Then 
the GUI will detect all attached devices automatically. Open the GUI and follow the instructions 
given in Chapter Using the Graphical User Interface (GUI). 

Alternatively, a VISA runtime environment (NI, Keysight or comparable) must be installed. 

Use VISA Write to send the *IDN? Query and use VISA Read to get the response. The USBTMC 
protocol supports service request, triggers and other GPIB specific operations.  

 

Connecting through GPIB 

Connect the instrument to the GPIB controller using the rear panel GPIB connector (option GPIB is 
required). Once connected properly, use VISA Write to send the *IDN? query and use VISA Read to 
get the response. The protocol supports service request, triggers and other GPIB specific operations. 

 

Installing the APSIN Remote Client 

AnaPico’s graphical user interface provides an intuitive control of the instruments. It runs under 
Windows™ operating system with minimum requirements. The DLL is embedded in the GUI 
application and requires the Microsoft® .NET™ framework to be installed. To install the GUI on the 
computer, insert the AnaPico USB memory stick to your computer and execute the GUI installer. 

The self-extracting setup provides easy installation and de-installation of the software. The setup 
program guides you in a few steps though the installation process. In case the NET framework is not 



 

  Page 18 – Signal Source Models – v3.07         Apr. 2024                           AnaPico AG - www.anapico.com – sales@anapico.com 

 

 

 
installed on your current Windows™ operating system, the setup procedure will assist you 
automatically to install the required version. For this you will need an active internet connection. 

Troubleshooting the LAN Interconnection 

Software does not install properly 

• Make sure the Microsoft .NET Framework was properly installed during the UI installation 
process. 

 
 

Software cannot detect any instrument  

• Make sure you have connected both computer and instrument to a common network.  

• If a direct connection is used you may require to reset your computer Ethernet controller 
(depending on the configuration).  Note that in that case detection of the instrument can 
take a considerable amount of time if your computer is configured to work with an external 
DHCP server. In some cases, the detection may even fail completely. Configure your 
computer network controller to an appropriate fixed IP instead.   

• Make sure that your software firewall enables the GUI to setup a TCP/IP connection via the 
LAN. Under Windows 7/10 you can do that like this:  
Open Control Panel under Settings in your Start menu. Then go to Windows Firewall. Click on 
Exceptions and then add Program. If the GUI is in this list, choose it and click OK otherwise 
you have to browse for the path to GUI installation directory. Finally close all open dialogs 
with OK. Now your Windows™ Firewall will not block requests from the GUI. 

Shutting Down the Signal Generator 

Press the line on/off switch on the rear panel or front panel to off. 
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Using the Graphical User Interface (GUI) 

AnaPico’s graphical user interface provides an intuitive control of the signal generator. It runs under 
any Windows™ operating system. Make sure the software is installed correctly and the computer’s 
firewall is configured properly. The GUI’s dynamic link library (DLL) uses the Microsoft .NET 
framework. 

Start the Signal Generator (SG) GUI 

After successful installation of the software double-click the software shortcut that has been created 
on your desktop. 

After start, the GUI will automatically detect existing AnaPico instruments that are connected to the 
computer (network) via local area network, USB, or GPIB. In the CONTROL tab (see Figure 10) the 
detected instruments are listed. Clicking on one of the devices will instantly establish connection. 
Clicking on an alternate device will disconnect the old device and reconnect to the new device. Scan 
Instruments button will enable automated scanning for new instruments. Disconnect/Connect 
button will establish and terminate connection. 

General Look 

1. The CONTROL tab completes the following function 

• Scan and establish connection to instrument 

• Configure remote interface (LAN, USB, GPIB) 

• Save, load and manage instrument memory states 

2. CW tab 

• Set correct frequency and phase 

• Set output power 

• Enable or disable the RF output power 

• Enable or disable the modulation signal 

3. SWEEP tab 

• Depending on the connected device you can select 

o Sweep over frequency range 

o Sweep over power range 

o Program a frequency and/or power sweep based on pre-defined list 

o Synchronize sweeps on multi-channel devices with synchronization capability 

4. MODULATION Tab 

• Enable or Disable pulse modulation 

• Enable or disable frequency modulation 

• Enable or disable amplitude modulation 
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• Enable or disable phase modulation 

5. REFERENCE Tab 

• Change reference source 

• Configure reference frequency output 

6. TRIGGER Tab 

• Configure the trigger system of the device used for sweeps 

7. LF OUT Tab 

• Configurate low frequency generator 

 

 

 

Figure 8: Control Tab 

Simultaneously controlling Multiple Signal Generators from one PC 

You can easily control multiple AnaPico instruments from a single computer but you need to start a 
separate GUI for every instrument as only one instrument is controlled by the GUI at once. 

Store and Load Instrument States 

Multiple memory states are available to store instant instrument settings. By clicking on the Device 
Settings Memory button, the currently saved memory settings are displayed and can be loaded or 
overwritten as shown in 1. To modify or enter a state, click on the appropriate line and select if the 
current instrument settings shall be stored in or loaded from the selected memory state.  

NOTE: Memory 0 is used as default state when the instrument is powered up.  
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The memory states can also be accessed via the front panel menu.  

 

Figure 9: Memory Settings Submenu 

Setting Network Configuration 

The Device -> Network Configuration dialog allows configuring the LAN settings as shown in 2. You 
may choose from three distinct network addressing modes: setting to Auto will check for a DHCP 
server on the network but if this fails, will fall back to assigning an address automatically using 
zeroconf. Setting to DHCP will check for a DHCP server on the network with no fallback option if one 
doesn’t exist. Setting to manual will require the user to supply all network settings for the device 
manually below. Additionally, the device name can be modified as desired. The unit serial number 
and firmware revision are displayed at the bottom of the dialog box. 

 

Figure 10: Network Configuration Submenu 
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Multi-Session Option 

The Multi-Session checkbox can be selected to enable the device to be accessed from more than 
one instance of the UI. This enables users on multiple computers on the network to connect to and 
configure the device simultaneously. It is the user’s responsibility to manage access conflicts whilst 
this mode is enabled (i.e. 2 users changing the same option from different PCs). 

Device Port Setting 

The ‘Port’ option allows the listening TCP port to be customized for the device. The default setting 
for all devices is port 18. If changed, the device will no longer be accessible using this port number. 
Any instances of the UI (or other VISA applications connecting to the device over a network) will 
need to modify their destination port number to match the device to connect to. 

Connecting to devices using a non-default port and non-default network interface 

There are 2 options for connecting to a device when its default listening port has been changed. 

1. Specify a temporary connection port 

Click the menu File -> Connection Settings -> Specify Connection Port. This will cause a new setting 
‘Custom Port’ to be displayed on the ‘Control’ tab of the UI (see 10). The connection port to use can 
then be entered (within the range of permissible TCP port numbers). Beware that this setting will 
overwrite the default port until it is removed. To remove, select ‘Specify Connection Port’ again – 
this will remove the ‘Custom Port’ setting from the UI and revert to using the current default port. 
Deleting the port number from the ‘Custom Port’ text box will also cause the UI to revert to using 
the default port. 

2. Change the application’s default port setting 

The global default port to use for connections can be changed by selecting menu ‘File’ -> Connection 
Settings -> Change Default Port (see 3). A default port can be entered into the dialog box which 
appears and set by clicking button ‘Set Default’ – only permissible TCP ports can be entered here. If 
the new default port is accepted, the ‘[Default=]’ text above will display the new setting. Beware 
that the new default setting will now persist until changed again – including after restarting the UI or 
rebooting your system. 

 

Figure 11: Default communication port and interface of the GUI 

Setting the GPIB Address 

If the instrument has the GPIB option installed, the GPIB address can be changed in the GPIB 
submenu in the control tab. Valid GPIB addresses range from 1 to 30. 
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To verify GPIB functionality, use the VISA Assistant available with the Agilent IO Library or the 
Getting Started Wizard available with the National Instrument IO Library. These utility programs 
enable you to communicate with the signal generator and verify its operation over GPIB. For 
information and instructions on running these programs refer to the Help menu available in each 
utility.    

Perform Firmware Upgrade 

A firmware upgrade of the instrument can be done directly via the GUI. First make sure you are 
connected to the right instrument and have the correct firmware binary file (.tar) ready. Then apply 
Device  Update Firmware and select the appropriate binary file that you have received from 
AnaPico or downloaded from the AnaPico website. The update will take a few minutes and after 
completion your instrument will reboot. Reconnect to the instruments after booting is completed 
and continue with the updated firmware.  

 

Do not disconnect and power off device during firmware 
update. 

Multi-Output GUI Control 

Individual outputs of the AnaPico multi-channel signal sources can be controlled by the GUI by 
selecting the corresponding channel above the control tab menu. Each channel can be configured 
fully independently as if they were individual signal generators. Note that the "Select Channel" 
appears only when connected to a multi-channel device. 

 

Figure 12: CW Tab with channel selection 
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Combined Modulation 

The tables below show what modulation types and sweeps can be active simultaneously.  

Some modulations can be combined with frequency and power sweeps. For those combinations, 
some timing restrictions apply. Check programmer’s manual for further details. 

Some combinations may be available only using the GUI or custom remote programming sequences, 
but not on the front panel. 

 

 
FM/PM 

INT / EXT 

AM 

INT / EXT 

PULSE 

INT / EXT 
LF Generator 

FM/PM 

INTERNAL 

EXTERNAL 

 

 

LIMITED [1] 

LIMITED [1] 

 

YES / YES 

YES / YES 

 

YES 

YES 

AM 

INTERNAL 

EXTERNAL 

  

 

NO/ NO 

NO/ NO 

 

NO 

YES 

PULSE 

INTERNAL 

EXTERNAL 

   

 

YES 

YES 

LF Generator     

CHIRP NO/NO LIMITED [2] LIMITED [3] YES 

Table 1: Possible combinations of internal and external modulation and the internal LF generator output. 

Remarks 

[1]  Combining AM and FM/PM is available to APSINx010 and APSINxxG only. 

[2]  Enable AM first since active chirp disables live update of other settings. 

[3]  In ALC on mode. 
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FM/PM 

INT / EXT 

AM 

INT / EXT 

PULSE 

INT / EXT 

Frequency sweep 

Power sweep 

List sweep 

LIMITED [1,2] LIMITED [1,2] LIMITED [2,3] 

Table 2: Possible combinations of internal and external modulation and sweeps. 

Remarks 

[1]  AM, FM, PM modulated carrier sweep is available to APSINx010 and APSINxxG only. 

[2]  Enable modulation first since active sweep disables live update of other settings. 

[3]  In ALC on mode. 
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Local Operation via Front Panel 

Most of the signal generator models offer direct front panel control.  

 

Figure 13: Front panel with touch display 

RF 50Ω connector This female N- type connector provides the output for RF signals. The impedance 
is 50 Ohm. The damage levels for RF and DC are specified in the datasheet. For APSIN it is +30 dBm 
maximum and the allowed DC level is +/- 10 V. 

Rotary knob is used to switch between menus and to continuously change values at cursor position. 

The currently active display position is shown by the cursor (underline symbol, or different 
background colour). The cursor does not move beyond the field of the currently selected parameter. 
Rotate the front panel knob to modify the value. Clockwise rotation increases the parameter and 
counter-clockwise rotation decreases the parameter. The parameter value will continue to increase 
or decrease by the amount of the selected resolution until it reaches the maximum or minimum limit 
of the parameter. 

Displayed Parameter Formats 

The following sections describe how to control the instrument via the front panel control by invoking 
various menu functions. 

CW Display 

The Main or CW Display is shown after the instrument has successfully booted and is ready. 
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Figure 14: CW Display 

Main Menu Display 

The bottom of the screen shows the Main Menu with the soft keys 
On the depreciated front CPC front panel the Main Menu Display is invoked by pressing the menu 
key.  

Sweep Submenu 

Frequency Sweep Submenu 

After accessing the Frequency Sweep menu, first of three displays allows to enter the start and stop 
frequency. On the second display the number of points and the on and off time can be entered. On 
the third screen select the sweep mode between LINear, LOGarithmic and RANDom. Also select the 
repetition mode between INFinite and 1 (single repetition).  

If you are using the depreciated front CPC front panel, the weep is started by pressing the RF On/Off 
button.  
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Figure 15: Displays shown for the frequency sweep configuration 

Power Sweep Submenu 

After accessing the Power Sweep menu, the first display allows to enter start and stop power. On 
the second display, the number of points and the on and off time can be entered. On the third 
display, select the repetition mode between INFinite, and 1 (single repetition).  

Using the depreciated front CPC front panel the sweep is started by pressing the RF On/Off button.  

List Sweep Submenu 

When entering the List Sweep submenu, a list of stored list sweeps is displayed. 

After accessing the List Sweep submenu, the first display allows to enter start and stop. Additionally, 
the number of repetitions of the list can be entered and the ALC can be set on or off. 

On the second display a particular list can be selected from the flash memory of the device.  

If you are using the depreciated front CPC front panel, all sweeps must be started with the RF 
on/off button on (green light illuminated) otherwise no signal will be output during the sweep. 

Modulation Submenu 
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Figure 16: Modulation Submenu 

Pulse Modulation Submenu 

In the pulse modulation submenu the pulse with, pulse period and pulse trigger can be configured. 

Amplitude Modulation Submenu 

In the amplitude modulation submenu the internal amplitude modulation can be accessed.  

Frequency Modulation Submenu 

In the frequency modulation submenu the internal and external frequency modulation can be 
accessed. It is possible to change between internal and external modulation source and to change 
modulation parameters such as modulation rate, depth or sensitivity. 

Phase Modulation Submenu 

In the phase modulation submenu the internal and external phase modulation can be accessed. It is 
possible to change between internal and external modulation source and change modulation 
parameters. 

Reference Submenu 

In the reference menu the internal or external reference source can be selected and configured. 
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Trigger Submenu 

 

Figure 17: Trigger Submenu 

Select SOURce: IMMediate, EXTernal, BUS (SCPI command), KEY (RF on/off button) 

Select SLOPe: POSitive, NEGative 

Select CONTinuous: ON, OFF (ON means that the trigger is re-armed after each trigger occurrence) 

Select RETRigger: OFF, ON, IMMediate (OFF means that any trigger event during execution of list is 
ignored)  

Enter DELAY: trigger delay in microseconds. 

Using the depreciated front CPC front panel: Press the RF On/Off button to arm the trigger. Exit the 
menu by pressing the menu key.  

LF OUTPUT Submenu 

In the LF OUTPUT Submenu the FUNCT OUT output can be configured at the rear panel of the 
instrument. 

On the first screen the source for the FUNCT OUT can be selected. Choose LFG for the low frequency 
generator, TRIG to enable the instrument trigger output and PULM to enable the pulse video output.  
If LFG is selected, select the waveform between sine, triangle, or square. Then enter the desired 
output frequency and voltage amplitude.  
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LAN Configuration Submenu 

In the LAN Configuration menu, IP address, subnet mask and DHCP can be configured.  

 

Preset Settings Submenu 

 

Figure 18: Restore Startup Settings 

Using the depreciated front CPC front panel: After accessing the Display Configuration menu, use the 
rotary knob to change the display contrast as required. Press the menu key to save and exit the 
Display Settings submenu 

Save Settings Submenu 

After accessing the Load Settings menu, use the rotary knob to get to the memory state you want to 
save. If you are using the depreciated front CPC front panel, Press RF ON/OFF key to save your 
settings  



 

  Page 32 – Signal Source Models – v3.07         Apr. 2024                           AnaPico AG - www.anapico.com – sales@anapico.com 

 

 

 
Load Settings Submenu 

After accessing the Load Settings menu, use the rotary knob to get to the memory state you want to 
load. If you are using the depreciated front CPC front panel, Press RF ON/OFF key to load.  

Load Defaults Submenu 

If you are using the depreciated front CPC front panel, press RF ON/OFF key button to load.  
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Remote Programming the Signal Generator 

The signal generator can be remotely programmed by using SCPI commands. Please refer to the 
Programmer’s Manual for details available on AnaPico’s website. There are also examples in 
different programming languages that can be used. 
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Battery Operation (B3 Option) 

If your instrument is equipped with an internal rechargeable battery (B3 option) it can be operated 
without the external power supply. Fully charged battery is good for up to three hours of operation 
at full RF output power. The same external power adaptor (6.3 V @ 5.71 A) is used for the battery 
version as for the standard model for both normal operation and charging of the battery. 

There are four operating modes that are also summarized in Table 2 below: 

normal operation– the external power supply is connected to the instrument and the device is 
turned ON (with the power switch on the rear panel turned ON). In this mode the instrument can be 
used as if no battery was present. The internal battery is not used and will NOT be charged.  

charging – the external power supply is connected to the instrument and the device is turned OFF 
(with the power switch on the rear panel turned OFF). In this mode the instrument is charging the 
internal battery. Once the battery is fully charged, the instrument goes into standby mode. Time 
required to complete charging is approx. four hours. 

standby – the internal battery is fully charged and the instrument is turned OFF.  

battery operation – the external power supply is disconnected and the device is turned ON. The 
internal battery is supplying the power until it is exhausted.  

 

Table 2: Operating modes of an instrument equipped with internal battery 

                External power 

                          adaptor 

     Power Switch 

 

supplying power 

 

disconnected 

ON 
Normal operation 

(no charging) 

Battery operation - until 

discharged (1) 

OFF 
Charging – when fully charged 

 standby (2) 
Completely powered off 

 

Notes: 
(1) The instrument will switch off automatically when the battery is discharged. It is recommended 
that the power switch is turned to the OFF position when the battery is fully discharged. 

(2) Termination of charging is automatic. The unit will then enter standby mode. The power adaptor 
can be left connected for any length of time. 

 

During operation the approximate remaining battery capacity is indicated by the battery symbol 
visible in the upper right corner of the display (see Figure 30). 
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Figure 19: Display with battery symbol 

Hints for maximizing the battery running time: 

1. Fully charge the unit before you use it. Toggle the power switch to ON and then OFF again 
while the instrument is powered by the external power adaptor. This will initiate a new 
charge cycle. 

2. Charging time of a completely discharged battery can be up to 6 hours. IMPORTANT: The 
battery will only be charged when the instrument power switch is in the OFF position. 

3. Batteries should always be charged at room temperature. Charging the instrument at very 
low or at elevated temperatures may result in early termination of the charging process for 
example the battery is not fully charged. For safety reasons the charging does not start when 
the internal temperature of the instrument is above 50 °C. 

4. Check the battery indicator in the upper right corner of the display. It should indicate full 
charge when running on battery power after charging (4 segments). 

5. Power consumption of the instrument is reduced when the RF power is switched off thereby 
increasing overall battery run time. 

6. Battery run time is maximal for ambient temperature between 15 and 25 °C.  Self-discharge 
of the battery is much faster at temperatures above 30 °C. 

7. Avoid storing the instrument in very hot places such as behind the windshield of a car 
parked in the sun. 

 

Hints for maximizing battery life expectancy: 

1. The battery will reach its best performance after the first few charge-discharge cycles.   

2. Always use the external power adaptor supplied with the instrument for normal operation 
and charging. This will make sure that the charging circuits work as specified. 

3. Fully charge the instrument after running it from the battery for an extended period of time. 

4. If an instrument with internal battery will be stored for a long period of time, fully charge it 
before storage, then remove the power adaptor and make sure that the power switch is in 
the OFF position. After storage, first charge the unit for 4-6 hours. 
 

To replace the battery at the end of its lifetime, please contact AnaPico or one of its distributors. 
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 NOTE: 

♦ Before using the instrument in battery mode for the first time, the battery must be fully 
charged.  

♦ Batteries must be disposed of according to the local environmental regulations. 
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Extended Power Range  

Some instrument models are available with option PE(X) that extends the power range towards 
lower power levels.  

With options PE, PE2 and PE3 installed, a mechanical step attenuator module is added. For the 
guaranteed minimum power level, please consult the respective datasheet. 

In sweeps where the mechanical attenuator is switched, the minimum dwell time increases to 20 
ms. 

PE4 are electrical attenuators with a very fast switching time. 
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Maintenance and Warranty Information 

Adjustments and Calibration 

To maintain optimum measurement performance, the instrument should be calibrated every 24 
months. It is recommended that the instruments be returned to AnaPico or to an authorized 
calibration facility. For more information please contact our Customer Service Department as 
indicated on www.anapico.com. 

Repair 

The signal generator contains no user-serviceable parts. Repair or calibration of the signal generator 
requires specialised test equipment and must be performed by AnaPico or its authorized repair 
specialists. 

Warranty Information 

All AnaPico instruments are warranted against defects in material and workmanship for a period of 
two years from the date of shipment. AnaPico will, at its option, repair or replace products that 
prove to be defective during the warranty period, provided they are returned to AnaPico and 
provided the preventative maintenance procedures are followed. Repairs necessitated by misuse of 
the product are not covered by this warranty. No other warranties are expressed or implied, 
including but not limited to implied warranties of merchantability and fitness for a particular 
purpose. AnaPico is not liable for consequential damages.  

The warranty on the internal rechargeable batteries (option B3) is one year from the date of 
shipment. Battery replacement is available through AnaPico and its distributors. 

Equipment Returns 

For instruments requiring service, either in or out of warranty, contact your local distributor or 
AnaPico Customer Service Department at the address given below or by filling out the web form at 
https://www.anapico.com/support/. 

Our support team will review your request and get back to you as soon as possible. They will provide 
you instructions and pricing estimations before returning your instrument. 

Please do not send material back to AnaPico before you receive an RMA number and written 
authorization. 

When you call, be sure to have the following information available: 

• Model number. 

• Serial number. 

• Full description of the failure condition. 

Note: Model and serial number can be found on the sticker of the instrument. 

https://www.anapico.com/support/
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You will get a Return Merchandise Authorization (RMA) number from AnaPico, please put it on the 
outside of the package. 

Instruments that are eligible for in-warranty repair will be returned prepaid to the customer. For all 
other situations the customer is responsible for all shipping charges. An evaluation fee may be 
charged for processing units that are found to have no functional or performance defects. 

For out of warranty instruments, AnaPico will provide an estimate for the cost of repair. Customer 
approval of the charges will be required before repairs can be made. For units deemed to be beyond 
repair, or in situations where the customer declines to authorize repair, an evaluation charge may be 
assessed by AnaPico. 

  



 

  Page 40 – Signal Source Models – v3.07         Apr. 2024                           AnaPico AG - www.anapico.com – sales@anapico.com 

 

 

 

 Document History 

 Version Date Author Notes 
3.0 25.09.2019 MH New layout introduced, screenshots updated 

3.02 21.10.2020 EE Product images updated 

3.03 18.11.2020 TL Added section on connection port settings & device multi-session 
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3.06 21.02.2024 AH/EE Updated available casing, photos and focus on touch display 
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